
The science behind the report:

Choose the HP EliteBook 845 G9 
Notebook PC for longer battery life 
and better performance scores while 
maintaining cool surface temperatures

This document describes what we tested, how we tested, and what we found. To learn how these facts translate 
into real-world benefits, read the report Choose the HP EliteBook 845 G9 Notebook PC for longer battery life 
and better performance scores while maintaining cool surface temperatures.

We concluded our hands-on testing on September 21, 2022. During testing, we determined the appropriate 
hardware and software configurations and applied updates as they became available. The results in this report 
reflect configurations that we finalized on September 1, 2022 or earlier. Unavoidably, these configurations may 
not represent the latest versions available when this report appears.

Our results
To learn more about how we have calculated the wins in this report, go to http://facts.pt/calculating-and-highlighting-wins.  
Unless we state otherwise, we have followed the rules and principles we outline in that document.

Table 1: Results of our benchmark testing. We ran each benchmark test three times and report the median result. Higher is better.

HP EliteBook 
845 G9 with 
AMD Ryzen 7 Pro 
6850U

Dell™ Latitude™ 
7430 with Intel® 
Core™ i7-1265U

Dell Latitude with 
7420 Intel Core 
i7-1185G7

HP EliteBook 845 
vs. Dell Latitude 
7430 percentage 
difference

HP EliteBook 845 
vs. Dell Latitude 
7420 percentage 
difference

3DMark (plugged in)

Fire Strike overall score 5,768 3,229 3,765 78.6 53.2

Time Spy overall score 2,319 1,328 1,406 74.6 64.9

3DMark (unplugged)

Fire Strike overall score 5,666 3,362 3,972 68.5 42.6

Time Spy overall score 2,398 1,328 1,423 80.5 68.5
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HP EliteBook 
845 G9 with 
AMD Ryzen 7 Pro 
6850U

Dell™ Latitude™ 
7430 with Intel® 
Core™ i7-1265U

Dell Latitude with 
7420 Intel Core 
i7-1185G7

HP EliteBook 845 
vs. Dell Latitude 
7430 percentage 
difference

HP EliteBook 845 
vs. Dell Latitude 
7420 percentage 
difference

PCMark 10 benchmark (plugged in)

Overall rating) 6,216 5,839 5,205 6.4 19.4

Essentials rating 9,896 11,344 9,868 -12.7 0.2

Productivity rating 9,129 7,496 8,225 21.7 10.9

Digital Content Creation 
rating

7,214 6,353 4,715 13.5 53.0

PCMark 10 benchmark (unplugged)

Overall rating 5,545 4,277 5,462 29.6 1.5

Essentials rating 9,000 8,691 10,121 3.5 -11.0

Productivity rating 7,846 4,991 8,211 57.2 -4.4

Digital Content Creation 
rating

6,554 4,897 5,322 33.8 23.1

PCMark 10 Applications (plugged in)

Overall rating 12,910 13,883 11,858 -7.0 8.8

Word score 6,655 7,401 6,793 -10.0 -2.0

Excel score 22,394 23,851 18,650 -6.1 20.0

PowerPoint score 15,360 16,381 13,279 -6.2 15.6

Edge score 12,136 12,848 11,754 -5.5 3.2

PCMark 10 Applications (unplugged)

Overall rating 10,830 8,789 11,032 23.2 -1.8

Word score 5,606 5,646 6,241 -0.7 -10.1

Excel score 17,359 16,583 17,602 4.6 -1.3

PowerPoint score 12,795 8,052 11,905 58.9 7.4

Edge score 11,052 7,915 11,326 39.6 -2.4

PassMark PerformanceTest 10.2 (plugged in)

Overall PassMark rating 5,852 3,302 3,361 77.2 74.1

CPU Mark score 21,424 11,948 9,555 79.3 124.2

2D Graphics Mark score 802 330 365 142.9 119.8

3D Graphics Mark score 4,039 2,740 3,204 47.3 26.0

Memory Mark score 2,677 3,108 2,666 -13.8 0.4

Disk Mark score 17,808 26,588 24,902 -33.0 -28.4
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HP EliteBook 
845 G9 with 
AMD Ryzen 7 Pro 
6850U

Dell™ Latitude™ 
7430 with Intel® 
Core™ i7-1265U

Dell Latitude with 
7420 Intel Core 
i7-1185G7

HP EliteBook 845 
vs. Dell Latitude 
7430 percentage 
difference

HP EliteBook 845 
vs. Dell Latitude 
7420 percentage 
difference

PassMark PerformanceTest 10.2 (unplugged)

Overall PassMark rating 5,384 2,800 1,500 92.2 258.8

CPU Mark score 20,730 11,843 6,184 75.0 235.2

2D Graphics Mark score 748 280 126 167.0 495.1

3D Graphics Mark score 3,881 1,759 2,416 120.6 60.6

Memory Mark score 2,277 2,847 2,437 -20.0 -6.5

Disk Mark score 17,394 24,641 24,041 -29.4 -27.6

Cinebench R23.200 (plugged in)

Multi-core score 10,518 7,015 3,641 49.9 188.8

Single-core score 1,541 1,507 1,335 2.2 15.4

Cinebench R23.200 (unplugged)

Multi-core score 10,523 5,608 3,826 87.6 175.0

Single-core score 1,546 1,564 1,351 -1.1 14.4

Table 2: Results of our battery life testing. We ran each test three times and report the median. Higher is better.

HP EliteBook 
845 G9 with 
AMD Ryzen 7 Pro 
6850U

Dell Latitude 
7430 with Intel 
Core i7-1265U

Dell Latitude 
7420 with Intel 
Core i7-1185G7

HP EliteBook 845 
vs Dell Latitude 
7430 percentage 
difference

HP EliteBook 845 
vs Dell Latitude 
7420 percentage 
difference

MobileMark 25

Battery life (hours:min) 10:26 9:50 5:41 6.1 83.5

Battery life (minutes per WHr) 
- Normalized

12.3 10.2 5.4 20.6 126.7

DC performance 847 912 1,001 -7.1 -15.3

MobileMark 25 index 530 538 341 -1.4 55.4

Productivity score 747 838 941 -10.8 -20.6

Creativity score 1,017 1,037 1,152 -1.9 -11.7

Responsiveness score 713 794 790 -10.2 -9.7
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Table 3: Results of our thermal testing. We ran each the workload 30 times and report the average score and temperatures under load. 

HP EliteBook 
845 G9 with 
AMD Ryzen 7 Pro 
6850U

Dell Latitude 
7430 with Intel 
Core i7-1265U

Dell Latitude 
7420 with Intel 
Core i7-1185G7

HP EliteBook 845 
vs Dell Latitude 
7430 percentage 
difference

HP EliteBook 845 
vs Dell Latitude 
7420 percentage 
difference

Thermal testing with Cinebench R23

Multi-core score (higher is 
better)

10,409 7,257 4,083 43.4 154.9

Keyboard deck average 
temperature (degrees Celsius) 

39.087 49.893 41.510 21.6 5.8

Underside of Chassis average 
temperature (degrees Celsius)

43.220 49.657 43.213 12.9 -0.0

Table 4: Results of our acoustic testing. We ran each test three times and report the average decibel level (dB) while idle and under load. 
Lower is better.

HP EliteBook 
845 G9 with 
AMD Ryzen 7 Pro 
6850U

Dell Latitude 
7430 with Intel 
Core i7-1265U

Dell Latitude 
7420 with Intel 
Core i7-1185G7

HP EliteBook 845 
vs Dell Latitude 
7430 percentage 
difference

HP EliteBook 845 
vs Dell Latitude 
7420 percentage 
difference

Acoustic testing with Cinebench R23

Baseline measurement (no 
systems)

24.00 24.00 24.00 - -

Idle 24.36 24.43 24.80 0.2 1.7

Idle difference from baseline 0.36 0.43 0.80 15.3 54.1

Under load 27.30 26.63 28.86 -2.5 5.4

Under load difference from 
baseline

3.30 2.63 4.86 -25.3 32.1
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System configuration information
Table 5: Detailed information on the systems we tested.

System configuration information HP EliteBook 845 G9 Dell Latitude 7430 Dell Latitude 7420 

Processor

Vendor AMD Intel Intel

Model number Ryzen 7 PRO 6850U I7-1265U I7-1185G7

Core frequency (GHz) 2.7 – 4.7 3.6 – 4.8 3.0 – 4.8

Number of cores 8 10 4

Cache (MB) 16 12 12 

Memory

Amount (GB) 32 (built-in onboard) 32 (built-in onboard) 32 (built-in onboard)

Type DDR5 DDR4 DDR4

Speed (MHz) 4,800 3,200 4,267

Graphics

Vendor AMD Intel Intel

Model number Radeon™ 680M Graphics Iris® Xe Graphics Iris Xe Graphics

Storage

Amount (GB) 512 512 512

Type PCIe® NVMe® PCIe NVMe PCIe NVMe

Connectivity/expansion

Wireless internet Qualcomm Fast Connect 6900 
Wi-Fi 6E

Intel Wi-Fi 6E AX211 Intel Wi-Fi 6 AX201

Bluetooth 5.3 5.2 5.2

USB 2 x USB4 Type-C,  
2 x SuperSpeed USB Type-A

1 x USB 3.2 Gen 1 1 x 3.2 Gen 1

Thunderbolt N/A 2 x Thunderbolt 4 2 x Thunderbolt 4

Video 1 x HDMI 2.0 1 x HDMI 2.0 1 x HDMI 2.0

Battery

Type Lithium-polymer Lithium-polymer Lithium-polymer

Size Integrated Integrated Integrated

Rated capacity (WHr) 51 58 63

Cells 3 4 4
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System configuration information HP EliteBook 845 G9 Dell Latitude 7430 Dell Latitude 7420 

Display

Size (in.) 14 14 14

Type WUXGA LED UWVA FHD AG,Non-Touch, WVA FHD AR+AS, SLP, Touch WVA

Resolution 1920 x 1080 1920 x 1080 1920 x 1080

Touchscreen No No Yes

Operating system

Vendor Windows Windows Windows

Name 11 Pro 11 Pro 11 Pro

Build number or version 2200 2200 2200

BIOS

BIOS name and version HP U82 Ver. 01.01.12 Dell Inc. 1.6.0 Dell Inc. 1.18.0

Dimensions

Height (in.) 0.76 0.68 0.68

Width (in.) 12.42 12.65 12.65

Depth (in.) 8.82 8.22 8.22

Weight (lb.) 3.6 2.13 3.0

Table 6: Pricing information for an HP EliteBook 845 G9, a Dell Latitude 7320, and a Dell Latitude 7420.

HP EliteBook 845 G9 Dell Latitude 7320 Dell Latitude 7420

Price (USD) $1,991.00* $2,549.00** $1,420.25***

*We collected pricing information on October 27, 2022 from https://www.hp.com/us-en/shop/ConfigureView?langId=-1&storeId=10151&catalogId=10051&catEn
tryId=3074457345620320837&urlLangId=&quantity=1. For processor, we selected AMD Ryzen 7 PRO 6850U; for memory, we selected 32GB DDR5; for storage, 
we selected 512 PCIe NVMe SSD; and for screen, we selected 14-inch diagonal WUXGA LED UWVA Anti-Glare for 5 MP Webcam (1920x1200)(250 Nits).

**We collected pricing information on October 27, 2022 from https://www.dell.com/en-us/shop/dell-laptops/latitude-7430-laptop-or-2-in-1/spd/latitude-14-7430-
2-in-1-laptop/s112l7430usvp#configurations_section.

***At the time of publication, this laptop was not available for purchase in the configuration we tested. We note here the price we paid for the laptop on 
August 23, 2022. 
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How we tested

Setting up the systems

Creating and updating the OEM Windows 11 Pro Image
1.	 Boot the system.
2.	 Follow the on-screen instructions to complete installation, using the default selections when appropriate.
3.	 In the bottom right corner, click the battery icon, and adjust the Windows Power mode (plugged in) to Best Performance.
4.	 Unplug the system, and in the bottom right corner, click the battery icon, and adjust the Windows Power mode (on battery) to Best 

Performance. Plug the system back in.
5.	 Set DPI scaling to 100%, and set Screen and Sleep options to Never:

• Right-click the desktop, and select Display settings.

• Under the Scale and layout section, for the Change the size of text, apps, and other items option. Select 100%.

• From the left column, select Power & Sleep.

• For all power options listed under Screen and Sleep, select Never.

6.	 Disable User Account Control notifications:

• Select Windows Start, type UAC, and press the Enter key.

• Move the slider control to Never notify, and click OK.

7.	 Disable Virtualization Based Security:

• Select Windows Start, type Group Policy, and press the Enter key.

• Select Computer ConfigurationAdministrative TemplatesSystemDevice Guard.

• Double-click Turn on Virtualization Based Security.

• Select Disabled, and click Apply and OK.

8.	 Run Windows Update, and install all updates available.
9.	 Launch the Windows Store app, and install all Store app updates.
10.	 Launch each vendor proprietary utility app installed on each system, and update any drivers or BIOS files:

• For Dell, run the Dell Command Update utility. 

• For HP, run the HP Support Assistant utility.

• To install the latest chipset and graphics drivers available, go to either https://www.intel.com/content/www/us/en/support.html or 
https://www.amd.com/en/support .

11.	 Verify the date and time are correct, and synchronize the system clock with the time server.
12.	 On the system with an Intel processor, install Intel CPU Runtime for OpenCL Applications for Windows OS (64bit or 32bit) from https://

registrationcenter.intel.com/en/forms/?productid=3207&pass=yes.
13.	 On the system with an AMD processor, adjust the AMD Vari-Bright setting to Maximum brightness:

• Right-click the desktop, and select AMD Radeon Software.

• At the Welcome to the new Radeon Software experience, click Skip This.

• In the top right corner, click the Settings Gear icon.

• Click the Display tab.

• Move the Vari-Bright slider to Maximum brightness.

14.	 Disable Automatic Windows Update:

• Right-click the Windows Start button.

• Select Computer Management.

• Select Services and Applications.

• Select Services.

• Scroll down, and double-click Windows Update.

• Click Stop.

• From the Startup type drop-down menu, select Disabled.
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Capturing an image
1.	 Connect an external HDD to the system.
2.	 Click Windows Menu button and type Control Panel in the search bar. Click Control PanelSystem and SecurityBackup and 

Restore (Windows 7)Create a system image.
3.	 Verify that the external HDD is selected as the save drive, and click Next.
4.	 Verify that all drives are selected to back up, and click Next.
5.	 Click Start backup.
6.	 At Do you want to create a system repair disc, select No, and close the dialogs.

Restoring an image
1.	 Connect an external HDD to the system.
2.	 Press and hold the Shift key while Restarting the system.
3.	 Select Troubleshoot.
4.	 Select Advanced options.
5.	 Select See more recovery options.
6.	 Select System image recovery.
7.	 Select the User account.
8.	 Enter the system password, and click Continue.
9.	 At the Restore system files and settings screen, select Next.
10.	 Verify that the external HDD is selected, and click Next.
11.	 Once the recovery has completed, click Finish.

Testing with MobileMark 25

This test requires a X-Rite - i1Display Plus colorimeter.

Avoiding antivirus software conflicts
MobileMark 25 is not compatible with any virus-scanning software, so we uninstalled any such software present on the notebook PCs before 
we installed the benchmark.

Avoiding pre-installed software conflicts
MobileMark 25 installs the following applications, which its test scripts employ:

Productivity

• Adobe® Acrobat® Pro DC

• Audacity

• Corel WinZip 24.0 Enterprise

• Google® Chrome 

• Microsoft Excel 2019 Professional Plus VL

• Microsoft Outlook 2019 Professional Plus VL 

• Microsoft PowerPoint 2019 Professional Plus VL

• Microsoft Word 2019 Professional Plus VL

• Shotcut

Creativity

• Adobe Photoshop® CC

• Adobe Lightroom® Classic CC

• Adobe Premiere® Pro CC

If any of these applications already exist on the system under test, they could cause problems with the benchmark due to software conflicts. 
To avoid any such issues, we uninstalled all conflicting pre-installed software applications—including different versions of any of the programs 
MobileMark 25 uses—before we installed the benchmark.
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Using the MobileMark built-in configuration tool
This tool supports three levels of configuration:

1.	 Only makes changes that are REQUIRED for the benchmark to run.
2.	 Additionally, makes changes that are RECOMMENDED for repeatable results.
3.	 Additionally, makes OPTIONAL changes that help ensure best results.

The configuration tool makes the following configuration changes at each of the three levels:

Level 1 - Required

• Disables User Account Control (UAC)

• Set DPI Scaling to 100%

• Disables Low Battery Actions

• Disables Network Proxies

• Disables System Sleep and Hibernate

• Disables Windows Update

• Enables Windows Search

• Disables WinSAT

Level 2 - Recommended

• Create BAPCo power scheme

• Set Power Plan Type to Balanced

• Set CPU Adaptive Mode

• Disables Battery Saver Dimming

• Verifies Battery Saver Threshold

• Disables Disk Defrag

• Disables Windows Error Reporting

• Disables Windows Lock Screen

• Disables Screen Saver and Monitor Timeout

• Disables Windows Security Center

• Set Font Smoothing

Level 3 - Optional

• Disables Hard Disk Timeout

• Disables System Restore

• Ignores Laptop Lid Close

• Enables Dark Mode

• No Wait for OpenMP Threads

We chose the official BAPCo “Run Benchmark” default as outlined in the BAPCo MobileMark25 User Guide (https://bapco.com/wp-content/
uploads/2021/09/bapco_mobilemark25_user_guide_v1.1.pdf), which runs the benchmark using the Required and Recommended options.
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Setting up the performance-qualified battery life test
1.	 On a separate PC, install the i1Profiler software from https://www.xrite.com/categories/formulation-and-quality-assurance-software/

i1profiler and connect the X-Rite - i1Display Plus colorimeter to that PC.
2.	 On the test PC, verify that the wireless adapter is enabled and connected to a wireless router that is not connected to the internet.
3.	 On the test PC, verify that the Lower screen brightness when using battery saver is turned off:

• Select Windows Start, type Battery saver, and press the Enter key.

• Click the down arrow next to Turns on at 20%, and next to Lower screen brightness when using battery saver, toggle the button to Off.

4.	 On the test PC, verify that the volume is set to 50%.
5.	 On the test PC, disable Windows Defender Antivirus:

• Select Windows Start, type Group Policy, and press the Enter key.

• Select Computer ConfigurationAdministrative TemplatesWindows ComponentsMicrosoft Defender Antivirus

• Double-click Turn off Microsoft Defender Antivirus.

• Select Enabled, and click Apply and OK.

6.	 On the test PC, install MobileMark 25 with the default options.
7.	 Reboot the system for the changes to take effect.

Running the performance-qualified battery life test
1.	 Boot the system. 
2.	 Select Windows Start.
3.	 Type cmd, and press Ctrl+Shift+Enter.
4.	 Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do not interact with the system until the 

command completes.
5.	 After the command completes, wait five minutes before running the test.
6.	 Launch MobileMark 25.
7.	 Click Run Benchmark.
8.	 Click the Brightness Profiler button.

• Allow the white screen to warm up for 30 minutes. After 30 minutes, click Skip.

• At the Panel Dark Luminance pop-up, select Yes, to use the value that is queried from the display.

• Place the X-Rite - i1Display Plus colorimeter in the outlined spot on the screen.

• On the test PC, to turn off the test overlay, toggle the F1 button.

• On the colorimeter PC, start i1Profiler program, and select Advanced.

• Click Display, and click Profiling.

• Next to Luminance, click the drop-down menu, and select Measure.

• In the drop-down menu that appears below, select Paper in booth.

• In the box with the image that says “Place your paper in the light booth,” scroll down so that you can click the Measure button.

• On the test PC, adjust the slider until the Target White luminance is met on the colorimeter PC.

• Once the correct Target White luminance is met on the test PC, click Done.

9.	 Click Continue.
10.	 The test will begin immediately. When prompted, unplug the AC power adapter. 

The benchmark is complete when the PC has fully depleted its battery and is no longer operational when running on battery power.

We executed the MobileMark 25 benchmark three times on the system and took the median performance score run as the representative 
performance result for that test.
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Testing with the PCMark 10 benchmark test

Setting up the test
1.	 Purchase and download the PCMark 10 benchmark from https://benchmarks.ul.com/pcmark10.
2.	 Install PCMark 10.
3.	 Launch PCMark 10.
4.	 Select Business Edition, and input the license key.
5.	 Close PCMark 10.

Running the test
1.	 Boot the system. 
2.	 Select Windows Start.
3.	 Type cmd, and press Ctrl+Shift+Enter.
4.	 Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do not interact with the system until the 

command completes.
5.	 After the command completes, wait five minutes before running the test.
6.	 Launch PCMark 10.
7.	 While on the Home tab, click Run to begin the test.
8.	 When the test completes, record the results, and shut down the system.
9.	 Repeat steps 1 through 8 twice more, and record the median results.

Testing with the PCMark 10 Applications test

Setting up the test
1.	 Install and sign into Microsoft Office 365.
2.	 Open Microsoft Word, Excel, and PowerPoint, and verify that each application is signed into the Microsoft user account.
3.	 Purchase and download the PCMark 10 benchmark from https://benchmarks.ul.com/pcmark10.
4.	 Install PCMark 10.
5.	 Launch PCMark 10.
6.	 Select Business Edition, and input the license key.
7.	 Close PCMark 10.

Running the test
1.	 Boot the system. 
2.	 Select Windows Start.
3.	 Type cmd, and press Ctrl+Shift+Enter.
4.	 Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do not interact with the system until the 

command completes.
5.	 After the command completes, wait five minutes before running the test.
6.	 Launch PCMark 10.
7.	 Select More Tests, and select PCMark 10 Applications.
8.	 Click Run to begin the test.
9.	 When the test completes, record the results and shut down the system.
10.	 Repeat steps 1 through 9 twice more, and record the median results.
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Testing with Cinebench R23

Setting up the test
1.	 Download and install Cinebench from https://www.maxon.net/en/downloads/cinebench-r23-downloads.

Running the test
1.	 Boot the system. 
2.	 Select Windows Start.
3.	 Type cmd, and press Ctrl+Shift+Enter.
4.	 Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do not interact with the system until the 

command completes.
5.	 After the command completes, wait five minutes before running the test.
6.	 Launch Cinebench.
7.	 Select FileAdvanced benchmark.
8.	 Set the Minimum Test Duration to Off.
9.	 Select either CPU (Multi Core) or CPU (Single Core), and click Start.
10.	 Record the result.
11.	 Wait 10 minutes before re-running.
12.	 Repeat steps 7 through 11 twice more, and record the median result.

Testing thermals and multi-core sustained performance with Cinebench R23

Setting up the test
A FLIR E6xt Infrared Camera is necessary for taking top and bottom skin temperatures.

1.	 Download and install Cinebench from https://www.maxon.net/en/downloads/cinebench-r23-downloads.

Running the test
1.	 Launch Cinebench.
2.	 Select FileAdvanced benchmark.
3.	 Set the Minimum Test Duration to Off.
4.	 Select CPU (Multi Core), and click Start.
5.	 Record the results for the next 30 iterations to verify how sustained performance is impacted.
6.	 At the end of each result, take a skin temperature photo of the top and bottom and report the hottest spots.

Testing with 3DMark

Setting up the test
1.	 Download the 3DMark from http://www.futuremark.com/benchmarks/3dmark/all.
2.	 To install 3DMark with the default options, double-click the 3DMark installer.exe file.
3.	 To launch 3DMark, double-click the 3DMark desktop icon. Enter the registration code, and click Register.
4.	 Exit 3DMark.

Running the test
1.	 Boot the system, and wait five minutes before running the test.
2.	 Double-click the 3DMark desktop icon to launch the benchmark.
3.	 At the 3DMark Home screen, click the More Tests button.
4.	 Select the desired benchmark to run (i.e., Fire Strike or Time Spy).
5.	 Move the slider button to turn off the “Include Demo” feature.
6.	 Click Run.
7.	 When the benchmark run completes, record the results.
8.	 Perform steps 1 through 7 two more times for each benchmark, and report the median of the three runs.
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Testing with PassMark PerformanceTest 10

Setting up the test
1.	 Install PassMark PerformanceTest.
2.	 Download PassMark PerformanceTest from https://www.passmark.com/products/performancetest/download.php.
3.	 To begin the installation, press Install.
4.	 Select Accept to accept the license agreement, and press Next.
5.	 After the installation is complete, deselect Launch Performance Test, and press Finish.

Running the test
1.	 To launch PassMark PerformanceTest, press the PassMark PerformanceTest icon.
2.	 To start the benchmark, press Run Benchmark.
3.	 When the test completes, record the results.
4.	 Repeat steps 1 through 4 two more times.
5.	 Report the median of the three runs.

Measuring acoustics

These tests requires the following items:

• Extech SDL600 Sound Level Meter/Datalogger with SD card

• Cinebench R23

Setting up the test
1.	 Place the laptop under test in a sound-proofed professional sound booth.
2.	 Set the Extech SDL600 on a tripod so that it is 30 centimeters in front of the laptop and 40 centimeters above it.

Measuring acoustics while idle

Running the test

1.	 Boot the laptop.
2.	 Select Windows Start.
3.	 Type cmd, and press Ctrl+Shift+Enter.
4.	 Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do not interact with the laptop until the 

command completes.
5.	 After the command completes, wait five minutes before running the test.
6.	 Start the Extech SDL600 Sound Level Meter/Datalogger, and allow the laptop to run at idle for 20 minutes.
7.	 At the end of the 20 minutes, stop the Extech SDL600 and record the average Idle (dB).
8.	 Shut down the laptop.
9.	 Repeat steps 1 through 8 two more times.

Measuring acoustics while running Cinebench R23

Setting up the test

1.	 Purchase and download the Cinebench R23 benchmark from https://www.maxon.net/en/downloads/cinebench-r23-downloads.
2.	 Launch Cinebench R23.
3.	 Select File->Advanced benchmark
4.	 Select File->Preferences, change the Custom Minimum Test Duration to 20 minutes, and click OK.
5.	 Exit Cinebench.
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Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

DISCLAIMER OF WARRANTIES; LIMITATION OF LIABILITY:
Principled Technologies, Inc. has made reasonable efforts to ensure the accuracy and validity of its testing, however, Principled Technologies, Inc. specifically disclaims 
any warranty, expressed or implied, relating to the test results and analysis, their accuracy, completeness or quality, including any implied warranty of fitness for any 
particular purpose. All persons or entities relying on the results of any testing do so at their own risk, and agree that Principled Technologies, Inc., its employees and its 
subcontractors shall have no liability whatsoever from any claim of loss or damage on account of any alleged error or defect in any testing procedure or result. 

In no event shall Principled Technologies, Inc. be liable for indirect, special, incidental, or consequential damages in connection with its testing, even if advised of 
the possibility of such damages. In no event shall Principled Technologies, Inc.’s liability, including for direct damages, exceed the amounts paid in connection with 
Principled Technologies, Inc.’s testing. Customer’s sole and exclusive remedies are as set forth herein.
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Running the test

1.	 Boot the laptop.
2.	 Select Windows Start.
3.	 Type cmd, and press Ctrl+Shift+Enter.
4.	 Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks. Do not interact with the laptop until the 

command completes.
5.	 After the command completes, wait five minutes before running the test.
6.	 Launch Cinebench R23.
7.	 In the Minimum Test Duration field, select Custom (20 minutes).
8.	 In Cinebench R23, simultaneously start the Extech SDL600 Sound Level Meter/Datalogger and click CPU (Multi Core) Start.
9.	 At the end of the Cinebench R23 run, stop the Extech SDL600, and record the average sound level (dB) while running Cinebench R23.
10.	 Shut down the laptop for 40 minutes and let it return to room temperature.
11.	 Repeat steps 1 through 10 two more times.

Read the report at https://facts.pt/yY0TC7p
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